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Introduction 

This manual provides detailed information about the real estate 

software Activimmo and allows you to use it right away. 

Besides the software’s description, this manual will guide you 

through the various screens of Activimmo. You will also find 

information about the features, various windows, advanced 

options, such as configuring the interface, customizing the 

software, etc. 

Whether you are a beginner or an experienced IT user, you will 

find all the information you need to be able to use Activimmo. 
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Presentation 

Overview 

Welcome to Activimmo. With this software, your work is faster 

and easier. It offers you significant productivity gains. 

Managing properties and contacts is greatly facilitated by an 

intuitive graphical interface. In addition, it includes tools that 

allow you to automatically publish to your own website. It also 

incorporates the ability to send your listings and documents to 

your clients by email. 

 

Navigation within Activimmo is simple and effective. It relies 

on a Windows-like interface to allow you to easily get started. 

The ergonomy of the Activimmo interface, developed in 

conjunction with professionals, was designed to simplify the 

work, record properties and contacts, create all your 

documents, etc ... can be done in just a few clicks. 

 

Activimmo allows you to insert all your agency data as well as 

documents you use. 

Thus, the documents to be produced automatically (commercial 

relaunches, sales agreement) will be YOUR documents and not 

standard documents. 

In addition, the specific data that you manage will be supported 

directly by the application; options and headings can also be 

added or removed from the data entry screens, Web pages, 

etc... In fact, the customization possibilities of Activimmo are 

endless. 

 

Activimmo is also a great tool to open to the Web, allowing 

instant creation of a website without having to worry about 

programming. Simply choose the type of website you wish to 

Simple and visual 

A customizable 

tool 

A software open 

to the world 
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have and launch the synchronization process. A few seconds 

later your products are available on your global showcase, 

offering an unlimited number of photos and presenting your 

properties, without shedding a single drop of ink. 

Your clients will be able to take a virtual tour within your 

showcased products without you having to do any work. 

Activimmo allows you to reach new clients through Internet. 

Finally, Activimmo is open to the world thanks to its 

customizable geographical and linguistic features, allowing it to 

adapt to all parts of the world. Thus, you can generate your 

emails in multiple languages. 

 

Where to find help? 

-------------------------------------------------------------------- 

Activimmo incorporates tooltips (information bubbles) who 

will accompany you every time. They appear when you position 

the cursor over a field to be filled in, on features, etc ... These 

information bubbles will be helpful when you visualize data 

about properties, contacts, etc. 

Activimmo also allows you to access online assistance in a 

single click on the icon of the buoy or by selecting the Menu 

Help/Online assistance or via the keyboard shortcut F1. 

 

-------------------------------------------------------------------- 

Activimmo comes with this User Manual to help you get 

started right away. The User Manual includes tutorials that will 

quickly train you to use the various functionalities of the 

software. In case the User Manual does not meet your 

expectations or if you need help right away, you can use the 

built-in Activimmo online assistance. 

To open the manual: Help Menu - User Manual 

 

-------------------------------------------------------------------- 

If you want to find out more about using the software or about 

the various possibilities of Activimmo, simply log on to the 

website dedicated to this software: 

http://www.activimmo.com/ 

Online Assistance 

The User Manual 

Find out more 

http://www.activimmo.com/
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InstallationInstallation 

procedure 

To install the Activimmo software, simply download it from 

our website, under the tab 'Download': 

http://www.activimmo.com/  

You can then use Activimmo using the icon that appears on 

your desktop or access it via the Start menu. 

Update Software 

The icon allows you to update your activimmo or you can do a 

search on the search bar of your pc by writing Activimmo 

update 

First Launch 

When you first launch the software, Activimmo will ask you to 

enter some basic information required for its use (defining 

sectors, agency contact information...). You will also be 

prompted to enter an activation code. This code will be issued 

when you provide us your unique Activimmo number which 

will be displayed on the screen. 

Once the application is activated, you must enter an 

administrator’s name and password. The Administrator will be 

responsible for managing the advanced software features as 

well as the application set up. 

 

 

http://www.activimmo.com/
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 Note: The administrator is considered as responsible 

for the operation of Activimmo. In a small structure, it will be 

the best IT user or the person who has been trained by 

Activimmo trainers. The administrator will in charge of the 

Users and Settings windows. 

The Activimmo administrator must read and fully 

understand the concept of advanced usage listed in this 

manual. 

To adjust the settings, you need to follow the procedure that 

starts when you first launch Activimmo. You will then be 

prompted to enter your agency contact information, insert 

sectors and add the property types. You can also adjust and set 

the default values that will be displayed every time you insert a 

property in the software. 

The parameters entered are not definitive. To modify them, you 

must click on the Customize data menu, then General 

Settings to update the agency data or on Properties to 

modify data relating to properties. 

In addition, if you want to publish your company's data and 

your ads on Internet, you must complete the information in the 

Directories tab (Under General Settings). To fulfill these 

settings, you must send us an email with your agency 

publication request on Internet along the name you chose for 

your Website. In return, we will provide you the information to 

add in the Directories tab. 

For further information on this topic, read the section about 

Activimmo Web functionalities. 

Adjusting Settings 
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Using Activimmo 

Description of the Interface 

After launching Activimmo, the first thing you see (blue 

background with integrated logo) is the Activimmo workspace. 

From here you have access to all Activimmo tools. 

At the top is the menu bar: File, Edit, Management, Tools, 

Customize data, Reports, Web, Window and Help menu 

which provides you assistance as well as various information. 

 

 

 

Under the menu bar there is another zone, the Toolbar (the 

bar where the icons are located) which allows you to quickly 

access some features or windows. 

 

 

 

 The first icon allows you to close Activimmo 

 

 The next four icons allow you to insert new data, make 

modifications, save and delete selected data. 

The Tool bar 
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 The next icon allows you to refresh all data loaded in 

memory. 

  

 The next four icons allow you to open the property and 

contacts management windows, manage offers and sales 

and open the agenda. 

 

 The next icon allows you to search by phone number.  

 

 The next set of two icons allows you to create a 

document and access the loan calculator.  

 

 The next two icons allow you to write and read 

intranet messages.  

 

 The print icon allows you to create property listings as 

well as create documents that you will be able to print directly. 

 The icon representing a hand allows you to hide/show 

sensitive data. 

 

 This icon allows you to update your website (Manage 

Web publications).  

 This icon allows you to quickly access the online 

assistance. 

 The last icon allows you to close the current window. 

 

 

 

 

 

 

 

 

 

. 
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The Menu 

From the Menu, you have access to all Activimmo 

functionalities.  

 

 

 

We will briefly explain these menus. 

Menu description: 

Here is the content of the File Menu: 

 

 

1- New Property: allows you to create a new property in the 

database. 

2- New Project: allows you to create new projects in the 

database. 

File Menu 
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3- New Contact: allows you to create a new contact (buyer, 

owner, notary...) 

4-New Advertiser: allows you to create a new advertiser. 

5-New Offer: allows you to create a new sale offer or rental 

offer for a property. 

6-New document: allows you to create a new document 

template. 

7-Newspaper Ads: allows you to create newspaper ads  

(newspapers/ magazines,…) 

8-Printing without parameters: allows you to print 

documents without having to modify the print settings 

9-Printing with parameters: allows you to print documents 

using the desired print settings (Orientation / Colour / Paper / 

etc...)$ 

10-Inter office synchronisation: allows you to synchronize 

multiple agencies databases. You will need to set the 

parameters beforehand in Activimmo (ID/ password,etc.) 

For help, contact your Activimmo technician. 

You will then have the possibility to export data to another 

agency or import data from another agency. 

You can choose to export modified data since xx days (by 

using the arrows to the right of the text ‘Only changes 

from...’); data concerning contacts; history and 

appointments as well as associated documents. 

You can also choose to import data regarding contacts; 

history and appointments as well as associated documents. 

All this can be done by checking/unchecking the desired 

options from the proposed list in the following window. 

Once your options have been chosen, click on OK to proceed. 
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11-Import a contact from clipboard: allows you to retrieve 

the contact’s information received by email, without having to 

re-type the information. Before importing a contact’s 

information from the clipboard, please ensure that each field is 

associated with a line. 

For example: Mr James Bond sends you an email. You will need 

to copy the data into a text editor (eg: Notepad). 

Then, from the File menu, select 'Import a contact from 

clipboard'. 

In the window that opens, you must ensure that each data is 

presented on one line. You will need to add the corresponding 

text before the data to allow the software to import the 

information correctly. In front of the first name of the contact, 

you will write: First name, same for the Name, telephone etc. 

Example: 

Surname: Bond  

Name: James 
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12-Import of property listing from clipboard: allows you to 

retrieve the property details received by email, without having 

to reenter the information. Before importing a property from 

the clipboard, please ensure that each field is associated with a 

line. (Same procedure as for ‘Import a contact’ explained 

above.) 

Example: 

Address: 12, Coastal Road  

Country: USA 

13-Send properties to another Activimmo agency: allows 

you to export all the information about a property to any other 

agency that also uses Activimmo. 

You will need to select your options from the top section of the 

popup window ‘Content of the email’: size of photos sent; 

maximum number of photos; include or not the owner sheet as 

well as the property details. 

You will then need to complete the bottom section of the popup 

‘Sending options’ by inserting the recipient’s email address 

and choose if you want to group the export files in a single 

email. Then, click on the button ‘Selection of properties to 

be sent’ to select the properties that you wish to export. 

Once done, click OK to proceed. 
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 $ 

 

14-Import a property from another Activimmo agency: 

allows you to retrieve information about a property from any 

other agency that also uses Activimmo. 

In the window that opens, select the desired actions by 

checking/unchecking the boxes from the proposed list: 

- Keep the original references of imported properties 

- Keep the original sales agent 

- Keep information about authors and creation/modification 

dates 

Note: You can drag and drop the files to import directly in this 

window. 

Once done, click on Import. 
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15-Send contacts to another Activimmo agency : allows 

you to export all the data of a contact to any other agency that 

also uses Activimmo. 

(Same as section 13 described on top: Send properties to 

another Activimmo agency) 

16-Import a contact from another Activimmo agency : 

allows you to retrieve the data of a contact from any other 

agency that also uses Activimmo. 

You can choose to keep the information about authors and 

creation/modification dates as well as Import search criteria for 

buyers. To do so, you will need to check the boxes from the 

options offered in the window that opens: 
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17-Exit: allows you to exit the Activimmo software. 
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Here is the content of the Edit Menu: 

 

 

The Edit menu allows: 

1. Modification of data, you enter the edit mode (F2) 

2. Save changes (F3) 

3. Insert new data (F5) or Delete (CTRL+DEL) selected 

data (new property, contact or new Activimmo user) 

4. Clone (Duplicate) a property, if for example you have 

a Duplex and that the information is pretty much the same for 

both properties. This will save you time as you can avoid 

having to re-insert the property details from scratch. (Example: 

address / photos etc…)  

You will need to insert the number of copies required and 

choose if you want to include the history of the property as well 

as the owner’s information by checking/unchecking the boxes 

in the popup window: 

 $ 
 

 Note: Remember to modify the reference of the 

duplicated property(ies) and feel free to personalise 

each one by adding relevant details. 

Edit Menu 
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5. Be more accurate in your search by using the advanced 

search (CTRL+F). You can add or remove criteria to refine 

your search. 

6. To show or hide sensitive data on your screen. For 

example, if you are with a prospect, you would not like him/her 

to see the details of the owners (name/ address/ etc.) You can 

therefore choose to hide this information. 
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The Management menu is the key menu in Activimmo as it 

lists and provides access to the various windows. You can 

access all the data managed by the application through this 

window. 

 

 

You can find all the information about: 

1. Properties (F9) 

2. Contacts (owners/ buyers / suppliers /etc.) (F10) 

3. New projects (Real estate promotions,…) (CTRL+P) 

4. Offers, sales and commissions [concerning 

properties] 

5. The agenda (multi-users) 

6. Managing advertisers, leads and newspaper ads 

[ads on internet portals or newspaper ads (newspapers, 

magazines…)]. 

7. Administer Activimmo users (allows Activimmo 

users to manage their access rights and their information.) 

Management 

Menu 
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The Tools menu is another important Activimmo menu, it 

provides access to a wide range of utilities such as a loan 

calculator in euros and a currency converter (Calculate a 

loan), search by phone number, sending SMS, documents 

creation; it can also perform automatic relaunches and 

launch a slideshow. You can also send or read your 

intranet messages and keep an eye on your task list.  

 

Here is the Tools menu: 
 

 

Tools Menu 



Activimmo User Manual Page   22 

 The Daily tasks option allows you to view a list of your 

weekly appointments and the upcoming tasks assigned to 

you. 

Click on a property reference to view the property 

information. (The property window will open on your 

screen). 
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 Send an Intranet message allows you to send a 

message to your work colleagues. To do so, you need to: 

 

1. Write the message in the text box 

2. Click on ‘Selecting the property related to the 

message’ and choose a property. Once done, you will 

notice that the property details now appear in this 

section. 

3. Click on ‘Select contact related to the 

message’ and choose a contact. 

4. Choose a recipient by ticking the box next to 

their name (on the right hand side of the popup). 

5. Click OK to validate and your message will be 

sent. 
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 Read Intranet messages  

– Click on this option to view messages received via the 

Intranet. 

- To view the message, click once on the row of the 

message and the content will appear. 

- To reply to an Intranet message, click on $‘Reply to 

the message’$. A window will open and you will need to 

insert your message and select a property as well as a 

contact (As explained on top: Send an Intranet 

message) 

- To delete an intranet message, double click on the 

bin icon on the row (on the right of the message). 

- To delete all intranet messages, click on ‘Delete all 

messages’. 

- Click OK once you are done.  

 

 $ 

 

 

 Send a Mailing 

This option allows you to send a mailing to a range of 

contacts at once. This includes newsletters; greetings; 

messages, activity reports, birthdays, etc.  

 

To do so, you will need to: 

 

- Insert the text for the subject of the mailing. 

- Add the email message content (using a template) 

- Add an attachment (or more) if any 
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- Select the recipient(s) using the button ‘Select 

recipients’ 

- Select the property(ies) using the button ‘Select 

properties’ 

- Choose a range for your mailing. You can choose to 

send the mailing to all your contacts at once or you can 

choose a range.  

 

For example: You can send the mailing to the first 50 contacts 

in your database by selecting ‘1-50’ in the range roll over. 

 

NOTE: If you choose to send a mailing to ALL your contacts, 

your PC might slow down depending on the amount of contacts 

you have in your database and also, it will depend on your 

internet connection. 

We therefore advise you to send big mailings before 

leaving the office at night. 

 

- Once ready, click on ‘Start the mailing’. 

 

 

 



Activimmo User Manual Page   26 

 Email alert (automatic relaunch) allows you to 

relaunch your prospects automatically.  

 

You will need to: 

 

- Select a document template to be used 

- Adjust the settings (sort to clients language/ Add the 

text for the email subject/ select the event associated to 

the relaunch (Relaunch/ Appointments/...) etc. 

- Choose the sending priorities (email/ paper/ fax,..) 

- Once done, click on OK to send the relaunch email to 

your contacts. 

 

NOTE: If prospects have already been relaunched, 

Activimmo will warn you about it. 

 

 $7 
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 Administrative tasks – allows you to do various tasks 

such as: 

- Retrieve GPS coordinates (works with Google Map) 

- Refresh data in the cache memory 

- Manage files and data  

- Archive contacts 

- Transfer files between sales agents 

- Export contacts & appointments to MS Outlook 

- Prepare & create a slideshow file for window showcase 

- Numbering client visit sheets 

 

 

 Tasks list – allows you to access the task management 

window where you will be able to view tasks assigned to 

each user. 

You can also choose to view the completed tasks by 

ticking the box next to ‘Show completed tasks’. 

Do not hesitate to select the view you wish to use to 

manage tasks. All this can be done using the roll over 

over menus on top of the window ‘Manage tasks’. 

From this window, you can not only add or delete tasks 

but you can also print the list in a single click on the 

button ‘Print’. 
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Incoming calls and client recognition settings $ 

This feature allows you to receive incoming phonecalls in 

Activimmo. To do so, you will need to adjust the phone 

line settings by clicking on the ‘Configure’ button.  

Incoming call history and Activity report are also 

found on this window so that you don’t miss out on 

opportunities. 

Use the ‘Simulate’ button to see how it will look like 

when you receive an incoming call. 

Once your settings are adjusted, click on ‘Start 

receiving’. 

Note that you can stop the incoming phonecalls at any 

time by clicking on the button ‘Stop receiving’.  
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Here are the contents of the Customize data menu: 

 

 

It is also an important menu in Activimmo, it allows:  

1. Customization of properties through various options 

such as adding details and categories. 

2. Customization of details and events related to contacts. 

3. Customization of data on offers (task/ status/ 

commissions etc.). 

4. Customization of geographical data of properties and 

contacts. 

5. Creation or modification of documents templates 

which are then accessible for use when creating new 

documents.  

6. Customization of general settings (that is the data 

specific to your agency or agencies in your network.) 

7. Customization of your Website (menu, choice of logo, 

foreign languages used, etc.) You can also choose the keywords 

used in the ranking of your Website on internet. 

 

Note: From this menu, you are able to translate and insert 

data in various languages offered by Activimmo. 

Customize data 

Menu 
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Example: Customize data – Properties 

When the window opens, the first thing to do is to select the 

primary language and the secondary language using the arrow 

(near the flag) to open the roll-over menu. Then, if you want to 

update the translation into the second language, just click on 

the text, delete it and replace it with the translation of your 

choice. 

In our example, under section 'Operations', for 'Location', 

you would probably want to update the text, in French, to 

‘Location non meublée’ instead of 'Location'. You will need to 

click on the text 'Location', delete it and insert ' Location non 

meublée' instead. When you are finished, click OK to confirm. 
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The Reports menu aims to issue activity reports and complete 

lists concerning your data (property listings, mandates, 

sales, contact listings and search criteria) in the simplest 

possible way. You can then print these reports. 

This menu also enables you to access sales agent’s statistics 

and view the appointments schedules (Agenda).  

The property input form allows you to obtain a detailed input 

form to print when you visit a new property. 

You are also able to view reports on graphs (Property graph, 

by sales agent, by sector, etc.) 

 

Reports Menu 
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The Web menu: allows the customization and sending of your 

Website to Internet. It looks like this: 

 

 

 

This menu is a real Website generator, allowing you to 

customize your Website by adding new pages 

Here is its description: 

1. Update Website (F12): allows you to send your 

Website to Internet. 

2. Publish properties to a portal: allows you to publish 

your properties to an online real estate portal. 

3. Import mandates from: allows you to retrieve 

mandates from real estate portals. 

4. View Website: allows you to view your Website when 

you are connected to Internet. 

 

 Update Website 

We offer you the possibility to update your Website directly 

from Activimmo. 

To do so, from the Web menu, select ‘Update Website’ or 

simply use the keyboard shortcut F12. 

The ‘Publish to your website’ window opens. The connection 

settings will have to be inserted at first use. 

[An Activimmo technician will help you to configure these 

settings.] 

Web Menu 
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Click on ‘Web Options’ to select the properties that you want 

to highlight on your Website (under each category below): 

- Coup de Cœur 

- Nouveautés 

- Défilement 

- Prestige ou  

- Affaire du mois  

 

$ 

 

When you click on the categories, the ‘Selecting Properties’ 

window opens. 
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Select a property by double clicking on the property row. Notice 

that it will move to the bottom section ‘Selected Properties’. 

Click ‘OK’ to confirm your selection. 

Note: You can select more than one property by double 

clicking on each property row or you can use the blu arrows: 

 

 The single arrows are used to select / deselect 

properties one by one.  

 

 

 The double arrows are used to select / deselect all 

properties at the same time. 

 

 

Before publishing your properties to your Website, please check 

the date in the section: 'Transfer all photos from'. 

Often this date is automatically updated with today’s date and 

it should be changed depending on when the last update of 

your Website was carried out. 

Example: You update your Website on the 10th December. On 

the 15th December, you decide to update your Website again. 

Before publishing, you will therefore need to check that the 

date that appears in this section is the 10th December and not 

the 15th December. 

In doing so, you ensure that photos of new properties that have 

been inserted between the 10th and the 15th December are 

taken into consideration by Activimmo and are uploaded 

before being published on the Website. 

Note:  The first time you upload the photos to be published to 

your Website, there might be a delay as Activimmo needs to 

scan and upload all photos that are in your database. Once this 

is done, try to avoid entering a date that is far back to avoid 

having to wait for the software to scan everything again and 

upload the photos. (This might also take longer depending on 

your internet connection). 

 

Once you are done, click on ‘Publish’. 
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 Import mandates from 

This function allows you to retrieve / import data from other 

real estate databases. 

In France and Belgium for example, they use EMULIS. Note 

that you need to be a registered member to benefit from these 

services. 

This service allows agencies to automatically retrieve data on 

other properties that are shared through this service. For more 

information, agencies must visit: http://www.emulis.net/ 

  

 

 

Once you are registered, you are given a Log in and password 

that you will need to enter in this window to be able to 

proceed. 

Then you will be able to synchronize and import mandates 

from their database.  

You can also choose to import photos. This is done by 

checking the box ‘Import photos’ in the bottom left hand side of 

the popup window.

http://www.emulis.net/
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The Window menu looks like this: 

 

 

 

Description of the various options: 

1. Cascade: Organizes the windows on top of each other. 

2. Horizontal layout: Organizes windows one above the 

other. 

3. Vertical layout: Organizes windows next to each other. 

4. Maximize current window: expands the current 

window. 

5. Minimize all windows: reduces all open windows. 

6. Close current window : closes the active window. 

 

 Note: Through this menu, you can also choose to 

show or hide the navigation bar. 

 

Window menu 
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The Help menu allows you to: 

1. Access to the online assistance (Team Viewer) – F1 

2. Browse through the User Manual 

3. Upgrade your local area network as well as 

Activimmo. 

4. Access Activimmo Website. 

5. Download Activimmo maintenance files 

 

The Help menu looks like this: 

 

 

Help menu 
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Method of use 

Activimmo uses different modes of operation for data 

management safety. There are two main modes: 

 

1. View Mode: In this mode, it is not possible to modify 

data. Indeed, in viewing mode, the fields in the property, 

contact or advertisers forms are not available for input. The 

data is shown in bold. To insert new data in the various tabs, 

you must switch to edit mode. 

 

2. Edit Mode (F2): It is also accessible via «Edit» from 

the Edit menu or via the second line of the vertical menu 

(sidebar) in the property and contacts window. 

This mode allows you to add or delete information about the 

selected object (which can be for example, a property, a 

contact, an advertiser or a sales agent). 

 

 Note: To save modifications made, you can: 

- Use the keyboard shortcut F3. 

- Click on «Save changes» from the Edit menu. 

Then select another property, contact or advertiser and 

your changes will be automatically saved. 
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Manage Properties 

The property window allows the advanced management of 

properties in an easy and efficient manner. 

To open the property window, click on the left vertical menu 

(sidebar) Properties or select Properties from the 

Management menu or use the keyboard shortcut F9. 

 

This page consists of: 

1. The properties table 

2. Various property search zones on top of the window. 

Note that these criteria can be combined and will be created 

based on your properties. For example, if no property is of type 

«House», you will not have the criteria «House» in the search 

box Property Type (Prop. Type). 

3. One box to check to publish the selected property to 

the Web. 

4. View property photos automatically (Slideshow). This 

can be accessed by clicking the option "View Slideshow" in 

the left vertical sub-menu (sidebar) under «Actions». 

5. 10 headings (Tabs Property, Details, Description, 

Media, Owner, Tasks, History, Documents, Ad, Client). 

6. A print button for documents related to properties. 
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This button allows you to create customizable property 

reports. You can sort them by type, price, owners, etc.  

You can also create documents for the selected property(ies). 

You can then send them by email, print, export to PDF and 

export to Word. 

 

 

Note that proposed documents available via this command 

can not be modified. If you want to print customizable 

documents, you need to select Documents templates from 

the Customize data menu. 
 

For adding new properties, simply select New Property from 

the File menu or click «Create a property listing» from the 

vertical menu (sidebar -under Properties) or use the keyboard 

shortcut Ctrl+F9 

When creating a new property, a window opens and prompts 

you to use the wizard. 
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 The wizard The wizard successively gives access to all 

input fields to create a property, such as the property data 

sheet but also a detailed sheet regarding the different rooms, 

the input sheet for the title and the text for the publication of 

ads, the photos insert page and finally to the general 

information sheet concerning the property owner. 

 

If you do not use the wizard to create your property, only the 

general information input window appears on the screen. 

It is therefore recommended to always use the wizard. 

 

 Tip: to move from one data (field) to another in the 

windows, you can use the keyboard with the tab key. This 

button looks like this: 

 

 

 Property Tab: 

It provides all the characteristics of the property, such as the 

property type, its condition, the sale or rental price, etc. 

If the vast majority of input fields it is not necessary to provide 

an explanation, it is still important to insert the following: 

1. The Reference is the name under which you will find 

the property in the property table. 

2. The sales agent information outlines the agency 

employee who looks after the property. 

3. To publish a property on Internet, just check the box 

Web. If you want to publish a property on the Web, you must 

create the complete text for the ad in the Desc. Tab. 

4. To archive a property, you must change the status of 

the property to Archived. Thus, the property will not be 

available for viewing on the Web anymore. You can still view it 

in Activimmo by selecting the box «Archived» in the search 

box at the top of the page under 'Status'. 
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 Details Tab : 

Allows you to view and detail the characteristics of the property 

that will be included in the property Web ad (for example 

details of the rooms located on the ground floor, 1st floor, etc.) 

To add new characteristics, click on «Add details about the 

selected property» (bottom of page). 

 

 

 Desc. Tab (description): 

Allows you to describe the property, these descriptions will be 

automatically included in the paper ads publications and on the 

Web. 

 Note: 

- The Title is is the name under which the property can 

be found on the Web page of your agency. 

- The Short ad/web text will be included in the 

published ads. 

- The Detailed ad text will be included in the property ad 

text on the Website only. 

 

 Note: the button «Edit the detailed ad text» 
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(button on the right of the detailed ad text) allows you to write 

text using ‘Word’.  

 

You can also edit the text layout in this window. 

 

To add a description, select Edit from the Edit menu. The 

page becomes available for input/editing. When you enter the 

text editor, it allows you to customize your text as desired. 

 

 Media Tab:  

Allows you to view, include and edit photos of the ad published 

on Internet. 
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VIEW MODE  

 

 

 

EDIT MODE 

 

 To add photos, click on «Click here to add photos». 

 

Add more photos by clicking on the folder icon. You can add a 

photo from your files (on your hard drive). You can also insert 

a photo directly from your digital camera. To do this, connect 

your device to your computer: 

- If your camera appears directly in your browser, select 

your photos, as if you were to look for them in your personal 

file.  

- If your camera does not appear in your browser, use the 

program supplied with your camera as usual to transfer 
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images to your computer and then follow the procedure 

described in the previous example. 

 

 If you want to edit your photos, (if they are previously 

entered photos, first select Edit from the Edit menu or use the 

keyboard shortcut F2). Then click the Edit button. The window 

that opens will allow you to edit the image without having to 

exit Activimmo. 

 

You can therefore: 

- Enlarge / reduce the display scale of the image. 

- Crop the photo (you must first select the part of the 

photo to keep). 

- Rotate the photo left or right. 

- Add text on the photo. 

- Edit text.  

- Delete text. 

 

 Note: Once you have saved the modified photo, you 

will not be able to edit/delete the modifications. 

 

- Add the Agency copyright. 

- Perform various modifications on the light effects, 

color, etc ... by clicking on Settings and Advanced Settings 

options. 

 

The Settings and Advanced settings options trigger the 

opening of a window which consists of two parts that allow you 

to edit or enhance your photos. The first part allows you to 

view the original photo while the second part allows you to 

view the modifications made. These windows offer access to 

many features that will allow you to: 

- Adjust the contrast and brightness. 

- Modify the color shades (Bump map). 

- Equalize your colours. 

- Insert a wave effect on your photos and adjust the 

effect by changing the various parameters offered.  
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- Insert other effects from the Morphing filter tab and 

set the morphing effect by changing the various parameters. 
 

 Note: To be used only by an experienced user. 

 

- Rotate your photos. 

 

 The Edit button also allows you to import an image from 

a scanner, a file and the clipboard. 

 The Actions button allows : 

- Upload a new photo. 

- Scan a new photo (source Twain). 

- Scan a new image (source WIA). 

- Import a photo from the clipboard. 

- Reload all photos from internet. 

- Send photos to your Website. 

- Save picture as... 

- Duplicate the photo. 

- Edit the photo using an external application. 

- Print photo (View mode only). 

 

 Owner Tab : 

Allows you to view and insert information about the owner of 

the property. 

 

 This button allows sending an e-mail to the owner. 

 

 This button allows you to call the (if your phone line 

goes through your computer, see Advanced Usage). 

 

If you check the «Archived» box, the owner will no longer 

appear in the list of owners (however you will still be able to 

view his information via the Contacts menu. To do this, you 

will need to select Owner (under category field ) then check 

the box Archived under 'Status').   
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To add or edit information about the owner, select Edit 

contact the vertical data menu (sidebar) or click Edit from the 

Edit menu or use the keyboard shortcut F2. The data sheet of 

the owner becomes available for modification. 

 

 

 

 Tasks Tab: 

Allows you to create tasks for the selected property. You can 

assign them to your colleagues (or yourself) and add a due 

date as well as notes. 

For example : Window display / Order display/ Fix signpost 

etc.. 

To create a task, click on the button «Add Tasks» at the 

bottom of the page. 

 

 Histo. Tab (History): 

Allows you to create and track the history of events for a 

property. You can see the number of visits made, telephone 

calls received, expert reports conducted and relaunches sent. 

To add events, select the name of the event and click the 

button «Add an event in history» at the bottom of the page. 

 

Then if you want to attach a document related to the event, 

click on this icon (right of the screen). 
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To edit an event from history, use the keyboard shortcut F2 

or use the Edit command from the Edit menu. 

 Doc. Tab (document): 

Allows you to both create a new document on the selected 

property as well as view the history of documents previously 

created. 

To create a document, Activimmo offers different operating 

modes: the easiest way is to click on «Create a document for 

this property» at the bottom of the page, but you can also 

select «Create a document» from the Actions menu (left) 

or via the Tools menu (top) or use the  keyboard shortcut 

F11. Then, simply select a template from the list provided by 

Activimmo. 

 

 Note: All created documents can be sent by email or 

via MS Word. They can also be exported to PDF. 

 Ad Tab: 

Allows you to manage publications. 

With this tab, you can prepare and send the ads to be 

published by your advertisers by e-mail. You can also view the 

history of publications on a selected property. 

For adding ads, select the name of the desired advertiser (on 

the left left) then use the buttons «Post ads to» and «Send 

ads to» at the bottom. 
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 Note: When you click the «Post ads to» button, the 

description entered for the property in the ‘Desc.’ tab is 

automatically taken to be the text of your ad. However, you can 

edit the text of the ad by clicking on the magnifying glass 

button on the right. 

 

 

 

Check the box Photo if you want the advertiser to publish the 

property photo.  

This is only available for paper ads 

This tab also allows you to control the number of 

publications and their total cost. 
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 Client Tab (prospects) : 

Allows you to edit the list of clients who may be interested in 

the property. To generate this list, the system examines all 

search criteria of prospects which are not archived and confront 

them with the characteristics of the selected property. When 

criterias are met, the prospect is automatically included in the 

list. 

 

 Note: 

The list appears in the form of a table in which you will find 

brief information about the prospects as well as 5 options to 

select from: relaunches, information, visited, documents 

and exclude. These options allow you to obtain essential 

information at a glance and implement appropriate actions. 

The buttons «Relaunch» at the top of the page and «Create 

a document» from the Actions menu allow you to print a 

commercial document relaunch for the property and the 

selected client. 

The email alert button (automatic relaunch) in the Tools 

menu allows you to perform the same task, but this time, for 

all potential clients. 

 

With this table, you can also view the selected prospect’s 

information sheet. This can be done by double-clicking or by 

positioning the cursor over the client’s name. The details of the 

client’s sheet will appear in a tooltip (information bubble). 

If you want to train on the creation of a property, you can go to 

tutorial No. 1: Create a property 

 



Activimmo User Manual Page   52 

Manage Contacts 

The contacts window enables the advanced management of 

clients, owners and other contacts. To open the contacts 

window, click on Contacts thought the Customize data 

menu, or select Contacts from the vertical menu (sidebar). 

 

This page consists of: 

- A multi-criteria search box (at the top of the window). 

- One box to check to view all archived contacts. 

- A table listing the contacts (in the centre). 

- 8 Headings (Tabs). 

 

 

To add new contacts, click on «Add contact» from the 

vertical menu (sidebar) or choose New Contact from the File 

menu. You can also use the keyboard shortcut Ctrl+F10. 

 

 Contact Tab : 
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Allows you to create and edit the characteristics of a contact. 

- The Auto relaunch box (Automatic Relaunch) allows 

you to relaunch a contact with all properties which could be of 

interest to him.  

- The Archived box means that the contact is archived, 

therefore, he will no longer be taken into account in search 

results nor in automatic relaunches for example. 

- This button allows you to call the contact (if your phone 

line goes through your computer, see Advanced Usage). 

- This button allows sending an e-mail to the contact. In 

addition to not having to insert the recipient's email address, 

this feature provides the ability to instantly archive the sent 

email in the history of the contact. 

 

 Details Tab: 

Allows you to add further information about your contact. Note 

that the list of available fields can be customized to suit your 

needs. 

Such details are available : Profession/ Financial data/ 

Current accommodation etc. 

To add new characteristics, click on «Add details to selected 

contact» (at bottom of page). 

 

 Criteria Tab : 

Allows you to create and view the search criteria of the 

prospect. 

To edit these criteria, select «Edit» from the Edit menu, or 

click «Edit Contact» in the sidebar (vertical menu). The 

search criteria fields then become available for modification. 

When you click on the name of a title, it turns orange. All the 

criteria that appear in orange are restrictive criteria. 

Therefore, when searching for a property using multiple 

criterias, the software meets all the criteria of elimination. 

Note that the criterias budget, types, property types, 

regions and sectors are restrictive criteria by default (they 

appear in orange). You can change this status with a single 

click on the coloured text: if text appears in orange, they 

become restrictive and if they appear in black, they become 

indicative. 
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To then view the list of properties matching the search 

criteria of your contacts, click the on the Property tab. 

If you want to create criteria lead customers to perform multi-

criteria searches, you can follow the lesson # 2: Create the 

criteria customers. 

If you want to train on the creation of clients’ criteria in order 

to use the multi-criteria search, you can go to tutorial No. 2: 

Create criteria for clients 
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 Properties Tab: 

This tab allows you to view the list of properties matching the 

restrictive criteria selected by the contact. The basic 

information relating to the property is featured as well as the 

percentage of criteria fulfilled in relation to the criteria of the 

contact. Example: If the score indicates 75, this means that ¾ 

of the client's criteria have been met. 

Click on the property row to obtain all the information about 

the selected. 

The print button allows you to create any document for the 

selected property and contact. 

From this tab, you can print documents as well as launch the 

slideshow of properties matching the search criteria of your 

contacts. 

 

 Tasks: 

Allows you to create tasks for the selected contact. You can 

assign them to your colleagues (or yourself) and add a due 

date as well as notes. 

For example : Call back / Send by email/ Deposit etc.. 

To create a task, click on the button «Add Tasks for this 

contact» at the bottom of the page. 

 

 Histo. Tab (History): 

It allows tracking of the history of events concerning the 

selected contact: visits done by a client, information provided 

about a property, phone calls from a property owner... 

To add an event in history, click on «Add in history» (bottom 

of page). 

To edit an event in the history, click on «Edit Contact» from 

the sidebar (vertical menu Contact) or select Edit from the 

Edit menu or use the keyboard shortcut F2. 

 Doc Tab (Documents) : 

Allows you to create specific documents (ex: display, 

descriptive, etc) on the selected contact. 

To create documents from this tab, click on «Create a 

document for this contact» ,at the bottom of the page, then 

select the document template desired and choose the property 

to be included in the document. 
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 Properties Tab: 

It shows you a list of different properties belonging to a 

contact. 

For example: Mr BOND owns 3 properties. You will therefore 

see his 3 properties listed in this tab. 
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Manage Offers and Sales 

This window allows you to manage offers, sales and 

commissions in general (Sale or Rental). 

To open the offers window, click on Offers on the left vertical 

menu (sidebar) or select Offers, sales and commissions 

from the Management menu, or click on the icon in the 

toolbar. 

 

               

 

This page consists of: 

1. A table for the offers (in the center) 

2. Search boxes at the top of the window. (Reference / 

Address / Operation / Agency / Statuts / etc.) 

 Note that these criterias can be combined 

according to your offers. 

3. 8 headings (Tabs: Offer, Commission, Details, Tasks, 

Documents (Doc.), Seller, Client and Property).  
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 $ 

 

To add new Offers, click on «Create an offer» or select 

«Insert new data» from the Edit menu. 

 

You will then need to : 

- Select a property and  

- Select a contact 

- Insert data in each tab. 

 

 Offer Tab: 

Allows you to create and edit the characteristics of an offer 

made on a property. 

You can: 

- See the property sheet 

- See the contact sheet (buyer) 

- Insert the offer amount 

- Insert the commission rate 

- Insert the offer status (under offer / accepted / etc.) 

- Insert the notary details for both parties 

- Write notes, etc. 

 

 Commission Tab 

Here you have the possibility to divide the commission between 

the different actors of the transaction. 
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To do so, you need to:  

 

- Click on the button ‘Add commission’ (bottom of page). 

- Click on the black arrow under ‘Sales contributor’ and 

select the sales agent(s) involved in the transaction from 

the dropdown menu.  

- Click on the black arrow under ‘Role of the contributor’ 

and select the amount of commission that should go to 

the contributor from the dropdown menu.  

 

 Note : The amount will be calculated and will be 

displayed automatically under the column ‘Amount’. 

 

- Once you have added all the contributors, click on the 

button ‘Recalculate commissions’. 

- You can also see the distribution of commissions on a 

graph if you check the box: View Graph 

 

 

 Details Tab : 

Allows you to add useful information in the offer. Note that the 

list of fields available can be customized to suit your needs. 

Such details are available : Sale/ Rental/ Loan amount/ 

Lease start date etc. 

To add new information, click on «Add data on selected 

offer» (at bottom of page). 

 

 Tasks Tab: 

Allows you to create tasks for the selected offer. You can 

assign them to your colleagues (or yourself) and add a due 

date as well as notes. 

For example : Write lease agreement / Send lease agreement/ 

etc.. 

To create a task, click on the button «Add Tasks» at the 

bottom of the page. 
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 Doc. Tab (Documents) : 

Allows you to create specific documents (ex: client visit sheet, 

etc.) concerning an offer on a property. 

To create documents from this tab, click on «Create a 

document for this property», at the bottom of the page, 

then select the document template desired. 

 

 Seller Tab: 

Allows you to view, create and edit the characteristics of the 

property’s owner(s). 

- The Auto relaunch box (Automatic Relaunch) allows 

you to relaunch a contact (owner) automatically or in groups. 

- The Archived box means that the contact (owner) is 

archived; therefore, he will no longer be taken into account in 

search results nor in automatic relaunches for example. 

- This button allows you to call the contact (owner) (if 

your phone line goes through your computer, see Advanced 

Usage). 

- This button allows sending an e-mail to the contact. In 

addition to not having to insert the recipient's email address, 

this feature provides the ability to instantly archive the sent 

email in the history of the contact. 

To add an owner, click on the button «Add Owner» 

 

 Note: A property can have multiple owners. (For 

example: Mr and Mrs Bond) 

 

 

If there are multiple owners, you can see the data of each of 

them by clicking on the blue arrow (bottom right of the 

screen). In this example, we see that there are 3 owners for 

this property. 
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 Client Tab: 

Allows you to view and edit the characteristics of the owner(s) 

of the property. 

- The Auto relaunch box (Automatic Relaunch) allows 

you to relaunch a contact automatically or in groups. 

- The Archived box means that the contact is archived; 

therefore, he will no longer be taken into account in search 

results nor in automatic relaunches for example. 

- This button allows you to call the contact (if your phone 

line goes through your computer, see Advanced Usage). 

- This button allows sending an e-mail to the contact. In 

addition to not having to insert the recipient's email address, 

this feature provides the ability to instantly archive the sent 

email in the history of the contact. 

 

 Property Tab: 

This tab allows you to view the property matching to the 

selected offer. There is basic information relating to the 

property. 

Example: Property type/ Number of bedrooms / Usable surface 

area / etc. 

You can view the property photos by clicking on the photo at 

the bottom right of the page. 
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Manage Ads 

This page allows a direct, real ad tracking with advertisers. It 

takes into account the publications caldendar of each 

advertiser. It publishes a specific ad for each property based on 

the short description filled in the tab Desc. of the property 

window. 

To open the advertisers window, click on Advertisers in the 

Management menu. 

This page consists of : 

 

1. Search boxes at the top of the window.  

2. One box to check to view all the advertisers (including 

the unavailable ones).  

3. A table in the center listing the various advertisers. 

4. 4 headings (tabs): Advertiser, Ads, Headings and Tariff. $ 
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To add new advertisers, select «New Advertiser» from the 

File menu or select «Advertiser» from the Management 

menu, right click and select «Create». 

You can also use the keyboard shortcut F5 (to do this. you 

must be in the Advertisers window, in the Advertiser tab or 

on the advertisers listing). 

 

 Advertiser Tab: 

Used to describe an advertiser, the name of the publication 

(newspaper, magazine ...), the name of the contact at the 

advertiser, the phone number, email address... 

- This button allows you to call the advertiser (if your 

phone line goes through your computer, see Advanced Usage). 

 

 

- This button allows you to send an e-mail to the 

advertiser. 

 

 Ads Tab : 

This tab allows you to view the history of the Ads published 

with each advertiser. You can also find out the cost, the 

number of publications and the size of your ads. 

 

You can view the entire text of the ads previously published by 

clicking on the gray button with 3 dots which is found at the 

end of the Ad text (on the right). 

 Headings Tab : 

Allows you to view, create (using the button «Add 

Newspaper heading») or delete the different headings of 

the advertiser (via «Edit» from the Edit menu). 

These headings will be useful when creating ads, you will find 

them under the tab Ad of the property window. 

 Tariff Tab : 

This tab allows you to set the price range by the number of 

characters matching an advertiser. 
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Example: Up to 200 characters, the price is equal to 15€. From 

201 to 500 characters, the price is 30€. Finally, the price will be 

equal to 45€ from 501 to 1000 characters. 

This information will be useful when you create ads as you can 

immediately know their prices. 

 

 

 

Publishing paper Ads 

With Activimmo, you can send the text of a paper ad (or 

several) to an advertiser (partner) by e-mail. 

You can use the Management menu to publish your ads: 

click on «Newspaper ads» and then select the desired 

advertiser. Then, select the date of publication of your ad 

using the calendar that appears on the screen. Select the 

properties to be published, validate the ad text and then 

select the desired option for sending (For example: send the 

ads by e-mail, print ads on paper or view all ads from this 

advertiser). 

Note: You can preview the ad before sending it by e-mail if 

you choose: View all ads from this advertiser and click on 

the View button in the pop up that appears on the screen. $ 
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The Documents 

Activimmo allows you, from the data completed in the 

different management windows, to create numerous types of 

documents: relaunches, displays, sales agreement or even 

listings and activity reports for your properties... They can 

be sent by e-mail or printed instantly. 

1) The documents : letters, sales agreement… 

These are relatively short and useful documents in the relation 

between the agency and the contacts. 

You can access these documents in the Documents tab (Doc.) 

from  the management windows (in this case the document is 

related to the selected object, property or contact). 

You can also access documents that were created in the 

'History' Tab (Histo.) from the management windows. 

 

To create a new document, click Create a document from the 

Actions menu in the vertical menu (sidebar) in the property 

and contacts management window. You can also click on the 

icon in the toolbar. 

When creating a document, windows appear and prompt you to 

choose the document template to be used and then, depending 

on the template, you will be required to provide additional 

information (property (ies) as well as contact(s) in relation to 

the document). The creation is then automatic: the system 

replaces the entry points using the property (ies) data, 

client(s)... Your document is then ready and can be editted if 

you wish. 
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 Note : By clicking on this button you can export your 

documents to Word. You will then only need to use the Save 

As command to save the document in your chosen location. 

[It is also possible to create or edit document templates, using 

the Customize data menu (see section concerning word 

processing in Activimmo)] 

 

 IMPORTANT: Automatic creation of a document is 

made from the «Document» tab in the various windows or by 

selecting Create a document from the Tools and Actions 

menus. 

 

2) The reports: Listings, activity reports, planning 

These are longer documents and are used to manage the 

agency and employees, they can not be sent by e-mail. 

To edit property listings, mandates or contacts, appointment 

schedule. Click on the Reports menu and select the report 

you wish to use so that it will appear on the screen. 

You can also edit the classification of data by clicking on 

‘sort by’ and choosing from the drop down menu or by 

selecting a specific report from the horizontal Reports menu 

(Contact List/ List of properties, etc). 

At the bottom of the window, there are 2 navigation buttons 

that allow you to move from one page to another and a button 

that allows you to print directly.. 

If you want to edit the date range of the listing on your 

screen, click on the arrow in the range box (Property 

entered..) and select from the drop down menu. 
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Activimmo Tools 

Activimmo allows you to access and use effective tools : 

1. Sending SMS 

2. Agenda 

3. Loan calculator 

4. Surface area convertor 

5. Search by phone number 

6. Slideshow 

 

 Sending SMS: 

You can send SMS from Activimmo when you are in the 

Owner tab in the property window, the contact tab in the 

contacts window, in the Agenda or at any time from the Tools 

menu in the toolbar. To do this, you will need to contact us so 

that we can provide a messages package. 

When you select this option, the following window appears on 

the screen: 
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This window is divided in 2 sections: 

The first section allows you to dial the number and select the 

destination country. 

By checking the box Delay sending on, you can choose the 

exact time and date for sending your message. You must then 

enter your account number and password to be able to write 

and send your SMS. To obtain an account and credit, you 

must contact our customer service team.  

Your message will be sent via Internet by clicking on the Send 

button. 

The second section allows you to monitor the message delivery 

by displaying its status and its reference. You will also be able 

to view the number of messages or credits remaining on your 

account. 

  Agenda:  

Allows you to manage the appointments of all employees, and 

schedule appointments between users and contacts. 

It also contains an area to write notes or memos. 

When opening the Agenda, in the right side, you can add or 

delete notes or tasks to be carried out. When you complete 

them, you can check the box at the beginning of the line: it will 

put a line through your notes (to cross it out). 

The left side of the page is for appointments.$ 
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- To create an appointment, select the date using the 

calendar and click on the appropriate time slot in the table in 

the center of the screen. Then click on «Create an 

appointment» from the vertical menu (sidebar) or right click 

with the mouse and choose «Create an appointment».  

Fill in the details in the window that opens on the screen: 

 

- Select contact – Click on this button to open the contacts 

window and select the desired contact. 

- Select properties – Click on this button to open the 

properties window and select the desired property. 

Once you have selected a contact and a property (or more), the 

information will appear as follows: 
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- When you finish your selection, click on 'Next'. 



Activimmo User Manual Page   72 

The window that follows offers you 5 optional features:  

1. Send email concerning the appointment 

2. Send an SMS confirming appointment  

3. Print the appointment 

4. Create a document related to this appointment 

5. Export this appointment to Outlook 

 

 $ 

 

 Note : when Activimmo is launched, it will remind 

you the appointment(s) by sending you a message before the 

scheduled appointment. 
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- To add a new type of appointment in the agenda (for 

example, a telephone appointment or a video conference), go 

the Customize data menu, select «Properties» then 

«Events», click on the button «Add new event», fill in the 

appropriate fields and then check the box «Show in agenda». 

When you select a date on the calendar, you can open the 

agenda on that specific week or on the selected date 

(View by day). You can then refine your search criteria by 

selecting the name of the sales agent(s) involved.$ 

 

 

The agenda opens automatically on the current week. If you 

select an appointment, the details will appear on the right. 

 

- Double click on the appointment to view information 

concerning the appointment. 

- A simple click on these 2 buttons allows you to view all 

informations concerning the contact and the property. 

 

- This button allows you to edit the property and the 

contact for your appointment. If you wish to edit the name of 
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the sales agent, you must double click on the appointment 

in the agenda. 

- To edit the appointment date, the property or the 

contact linked to the appointment, you can also click on the 

appointment (single click). You can then edit the details (shown 

on the right) or you can double-click on the appointment and 

complete the empty fields in the window that appears on the 

screen.  

 

 IMPORTANT: Remember that appointments or notes 

correspond to one day, you must therefore select that specific 

day to view the appointments for that day. 

 

 Loan Calculator 

This calculator (Loan Calculator in the Tools menu), enables 

you to calculate loans (monthly, total cost ...). It also converts 

the «local currency» to a foreign currency or vice versa. 

You can choose from the dropdown menu, at the top right of 

the screen, the currency which you want to use. $ 

 

 

 



Activimmo User Manual Page   75 

 

 



Activimmo User Manual Page   76 

Surface area convertor : 

This tool allows you to convert surface areas between various 

measures. For example, a plot of land of 800 square meters is 

equal to 8611.280 square feet / 18,949 perches etc. 

When you complete a field with a measurement, the conversion 

in the other fields is automatically displayed. $ 
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 Search by phone number:  

This tool allows you to search a contact using his phone 

number or his name. 

 

 

 

When you type the name or full phone number, you get all 

the main characteristics of your contact. 

 

However, you can also enter only the beginning of a number, 

then the search will give you a list of people who have a 

number starting with the one you entered. By double-clicking 

on a person’s name from the list, Activimmo immediately 

gives you all the relevant information. 

 

If you type the beginning of a name in the search box, 

Activimmo will do a search based on names, surnames, e-mail 

address. 

 

 

 

 Slideshow: 

Activimmo allows you to view all the photos of available 

properties (in the property list) in a slideshow. You can also 

customize your slideshow based on the properties matching the 

search criteria of your clients. 

You can access this tool by selecting Properties from the 

Management menu, then under the Actions menu, on the 

vertical bar (sidebar), choose «View Slideshow». Or on the 
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top right hand side of the window, click the slideshow icon, 

then choose an option from the following: with the current 

property, with the current properties, with the selection 

of properties or slideshow with options. 

 

When selecting Slideshow with options, the following window 

opens : 
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The slide is controlled from the keyboard. You can then: 

1- Scroll through the photos one by one using the left 

and right arrows or the + and - keys on the numeric keypad. 

 

 Note: If you have selected several properties for the 

slideshow, by using the arrows left and right, you will 

automatically jump from one property to another. The 

reference number of the property will be displayed on each 

photo. 

 

2- Exit the slideshow by pressing on the ESC (escape) 

button.  

3- Scroll or stop the slideshow automatically with the 

keyboard key 5 on the numeric keypad. 
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Advanced Search 

Multi-criteria Search 

Activimmo has an advanced search tool that allows you to 

instantly filter information that is of interest you. In a multi-

criteria search, the system reconciles the relevant properties in 

your database to the search criteria of your prospects. 

This function can be accessed via the main menu Properties - 

Actions – Advanced Search (or by clicking on the 

house/magnifying glass icon in the filter bar (search box) 

or from the Contacts menu, the Criteria tab (you will then 

need to fill in the fields matching your search, and then click on 

the Property tab to view the list of properties matching your 

search). 

 

Contact –Criteria Tab: The search criteria window opens, 

simply fill in the appropriate fields. In fact, the window is 

divided into different headings (Tabs) such as budget, types, 

property type, sectors, number of bedrooms, minimum 

condition required, garage , land surface area, swimming 

pool, surroundings, etc... 
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 Note:  

Criteria that appear in orange are restrictive criteria, while 

those that appear in black are indicative criteria. 

To render a criteria restrictive, simply click on its name and it 

changes its colour to orange; if you click on the name of a 

criteria which has orange letters, it will then turn into black 

and becomes indicative. 

Note that the criteria: budget, types, prop. Type, regions 

and sectors are restrictive criteria by default. It is up to 

you to change them (in a single on their name) except for 

budget which will always remains a restrictive criteria. 

Properties resulting from an advanced search fully comply with 

the criteria entered. 
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Manage documents templates 

In addition to its tremendous property and contacts 

management capabilities, Activimmo also integrates a word 

processor. It is therefore possible to create and manipulate 

documents without using any other software. 

We have already seen the automatic creation of a document 

(using Activimmo templates) in the section of the manual 

concerning documents. Here we will see how to create your 

own document templates. 

Creating your own document templates is done through the 

Customize data menu, by clicking on Document Templates. 
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This gives you access to the document templates manager: 

 

 

 

From this window, you must select a template from the list and 

click on the edit button. You will then have access to the 

integrated word processor: 
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Operating the word processor 

 

The word processor integrated in Activimmo has the same 

appearance as any other word processor. 

 

 

 

In addition, it offers the possibility to insert elements from your 

database in the form of merge fields. 

 

 

Merge Fields: space to insert text (eg: Names, addresses, 

details, etc... about your properties and contacts) or images 

(eg: Property photos from the Activimmo database).  

 

Merge fields can be recognised as the text is usually in-

between quotes and has a grey background when you 

click on it. For example: «name_contact» 

 

 

You can therefore create your own document templates that 

will be automatically completed by the appropriate information 

in the desired locations concerning contacts and properties 

concerned. 

When opening the word processor (Text editor), you will notice 

the classic menus: File, Edit, Display, Format, Table and 

Insert that list the usual functions such as saving, opening 

files or arranging the page layout of the document, etc. 

 

 
The File menu allows you to edit the layout, print settings, 

sending by e-mail... 

 
The Edit menu integrates several standard features of the Edit 

menu of a word processor. 

 
The Display menu allows you to change the display of your 

templates on the screen. You can easily access the header and 

footer of a document from this menu. 

 

The Format menu allows you to customize the appearance of 

text by choosing its font, size, colour...  

 
The Table menu allows you to insert or delete a table. When you 

insert a table, a window appears asking you how many columns 
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and rows you want to create. 

 
The Insert menu allows the insertion of images, breaks pages, 

external documents or number of pages. 

 
The Preview menu allows you to see the end result of a 

document as you create it. 

 

The remaining menus will allow you to insert merge fields 

where the text cursor is located in your new document 

templates. 

 

 Note: 

The merge fields names are only visible in edit mode and 

are surrounded by quotation marks: « ». They will then be 

replaced by the appropriate data of your contacts and 

properties (the software may ask you to select a contact or a 

property, depending of the type of document, through 

additional windows) during the automatic creation of your 

document. 

 

 
The Contact menu: allows you to include merge fields for 

contacts. In addition, in this menu you can access the merge 

fields concerning the client's notary. In case you have a 

property from another agency, you can insert these details 

using this menu. 

 
The Owner menu: allows you to include merge fields on a 

property owner. You can also access the data regarding the 

owner’s notary. 

 
The Appointment menu: allows you to include merge fields 

for the appointment with a contact. 

 
The Property menu: allows you to include merge fields about 

the property as well as all financial data regarding your 

properties. 

 
The Offer menu: allows you to include merge fields 

concerning the offer on a property. You can also access the 

data concerning the buyer, the owner, the commissions etc. 

 
The User menu: allows you to include merge fields concerning 

various information types such as the current date or all data 

about the user.  

 
The Agency menu: allows you to include merge fields 

concerning the Agency (name, logo, address, etc). The merge 

field «today’s_date» (Creation date of the Doc.) will be 

replaced by the date of creation of the document and not the 
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date of the creation of the document template. 

 Note: The automatic creation of a document is made 

from tabs «documents» from the various management 

windows as well as from clicking on «Create Document» from 

the Tools menu or by using the keyboard shortcut F11. 

During this automatic creation, windows appear and prompt 

you to select a document template as well as a property(ies) 

and the contact(s) linked to it. The system then handles the 

automatic creation by replacing the merge fields with the 

property(ies) and contact(s) data: your document is ready in a 

few clicks. 

 

Example:  

«address_property», will be replaced by the address of the 

selected property when creating a document, for example: 25, 

Port Road. 

 

Summary Table: 

 Document Template Automatic creation of 

document 

Data 

processing 

Merge fields Actual data 

Example «address_property» 25 Port Road 

 

To create your customized template, click on Document 

templates from the Customize data menu and then click 

New. 

 

Inserting details in your document templates: 

To insert customized details in your documents, click on the 

Property menu and select Details: 6 options appear (all, 

First half, Second half, Types of specific details, Specific 

details and List of details). 
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If you select Types of specific details: 

1 – A window will open and offer you a list of types of details. 

$ 

 

 

2 - Select the ones you wish to insert. 
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3 - The software will insert them in your document. 

Example: If you select the detail $ «Other rooms» $, the 

software will bring up all the details related to this designation. 

 

 Note: 

The word processor is compatible with Word. Thus, 

exchanging documents can be done with these two softwares 

using copy / paste or by clicking on this icon. 

 

You can also export your documents in PDF format by clicking 

on this icon. 

 

 

Create a document template 

 

Follow these steps to create your own document template: 

- From the Customize data menu, select Document 

templates 

 

 

 

- When the window 'Manage document templates' 

opens, click on 'New'. 
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- Insert the name of your document template in the 

window that follows (Example: TEST DOCUMENT) and 

click OK. 

 

 

- A document will open. We recommend that you close 

this document using the cross (X) in the upper right of 

your screen. By doing so, you will have access to the 

'Preview' function which will help you visualise your 

document as you create it. 

 

Note: You must click on the document template’s name on the 

left (to select it) and click on 'Edit' in order to proceed. 

When you open the document, you will see the name of your 

template at the top of the page. You will also notice that the 
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template (which is based on the basic template: Normal) has a 

merge field (LOGO) inserted in the header of the document as 

well as merge fields inserted in the footer: Agency name / 

Address / Tel / Fax and Website. 

If you want to delete these merge fields, you will need to 

double click on the header / footer section to select this, click 

once in the middle of the merge field and press the 'Delete' 

key on your keyboard. 

For a document template (text) which is sent in an email 

(Example: Email content), the header and footer are not 

taken into account. Therefore, you can remove this 

information. 

 

 

You are now ready to create your document template. 

Note: As mentioned above in the section: Operating the 

word processor, the top menu is similar to other word 

processing editors. 

You can add merge fields relating to the Contact; the 

Owner; the Appointment; the Property; the Offers; the 

User and the Agency. 

In our example, we will create an email content for a contact: 

- Position your cursor on the first line in your document and 

click. 

- Click on the menu ‘Contact’ on top of the screen and 

select ‘Greeting style (long)’, you will see the merge 

field: «greeting_style_contact_long» appear in the 

document. Press the ‘space bar’ on your keyboard. 

-  Click once more on ‘Contact’ and select ‘First name’, 

you will see the merge field: «first_name_contact» 

appear after the ‘greeting style’ and the ‘space’. Press the 

‘space bar’ once more on your keyboard. 

- Click on ‘Contact’ and select ‘Name’, you will see the 

merge field «name_contact» appear (as explained 

above). 



Activimmo User Manual Page   91 

 

 

- Insert the content of your message and if you have 

data to insert concerning the property, you will be able 

to add it using the menu ‘Property’; if you have data to 

insert concerning the owner of the property, you will be 

able to do so using the menu ‘Owner’ etc. 
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Your document now looks like this: 

 

 

 

WARNING: 

 When you see this symbol: << \ >> (back slash) in a 

merge field, this means that the corresponding data will 

appear on a new line when you merge the document. 

 The word ‘ MAJ: ’ added in a merge field means that 

when merging the document, the text will appear in 

Uppercase. 

 The word ‘ MIN: ’ added in a merge field means that 

when merging the document, the text will appear in 

Lowercase. 

 

We also offer the possibility to add text in the merge fields 

in order to make your documents more dynamic. 

 

 This way, if a merge field inserted does not match 

the data inserted in a property for example, this field 

will not appear in the final document.  

 If the inserted data includes the information that we 

require, the merge field along with the inserted text 

will appear in the final document. 
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Example : James Bond 

Merge field: Name: «name_contact» 

 

 If the contact’s name is in the database, when you merge 

the document, you will be able to read:  

Name: Bond 

 If a contact’s name is not in the database, this line of 

text will not appear in the document when you 

merge it. 

 

 

 

 

 

- To view your document, click on ‘Preview’ 

Activimmo will ask you if you want to ‘Save the 

document’, click on ‘Yes’ in the window that opens. 

- A second window opens and prompts you to select a 

contact. 

Select a contact by double clicking on the row of the 

contact. You will see the contact move to the bottom 

section of the screen ‘Selected contacts’. Then click on 

‘Next’. 

 

Note: You can select more than one contact by double clicking 

on each line or you can use the blue arrows: 

 

 The single arrows are used to select / deselect contacts 

one by one.  

 

 

 The double arrows are used to select / deselect all 

contacts at the same time. 

 

 

THE FUNCTIONS MENTIONNED ABOVE MUST ONLY BE 

USED BY AN EXPERIENCED USER AS HANDLING MERGE 

FIELDS IS VERY DELICATE AND MAY RESULT IN LOSS 

OF DOCUMENTS ! 
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You will then see your document appear on the screen and the 

merge fields have been replaced with the contact’s data (when 

you selected a contact in the previous window). 

 

The merge fields can be seen in bold below: $ 
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Once you are satisfied with the document template, you can 

close it by clicking on the cross on the top right hand corner of 

the screen. 

Note: There is no need to save a document when you 

preview it. 

Therefore, you will say ‘No’ in the window that follows: 
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Inserting a photo in a document template 

- In your document template, place your cursor where you 

want to add your photo. 

- Click on the menu ‘Property’ and choose ‘Photos’, then 

select the size of the photo.  

 

 

- A window then opens and you will have the following 

options: 

1. Photo number (in the order that they are featured in 

the ‘Properties’ page, in the ‘Media’ tab. 

2. The size of the image in percentage. 

3. The size of the image in pixels. 

This option will allow you to block the length and width of 

your photos to avoid the overflowing when creating 

documents, in case your photos have different sizes. 

(They will be locked in a frame).  
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Example: panoramic photos compared to a standard photo 

taken from a digital camera). $ 

 

 

 

- Once done, click on OK to validate. The merge field for 

the photo will now appear on your document template 

(including the size entered in the previous screen if you 

chose the size in pixels option.): 

 

 

- To view your photo, click on ‘Preview’, answer ‘Yes’ 

when asked if you want to save the document, then 

select a property in the following window. (same 

proceure as descrived above). Then click on ‘Next’. 
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The photo has been merged in your document template: 

 

 

There are many options offered through the document template 

creation window such as: inserting tables, add borders, change 

the text color, change the background color, add 'styles' to the 

text (Title 1 / Details, etc..), insert pictures (with captions) 

insert site plans, print documents, export as PDF or Word 

document sent by mail ... 

The list is long! 

 

For further information about the creation of document 

templates, contact your Activimmo technician. 
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Multiplying properties 

 

If you want to create a document for several properties, you 

must create a replicated and modified zone for each property. 

Merge fields contained in this zone will be automatically 

replaced by the data of all the selected properties at the 

automatic creation. 

To start this zone, you must use Start property zone from the 

Property menu. 

To end this zone, you must use End of property zone from 

the Property menu. 

 

 

 

 

Thus you will get a zone between these two limits: 
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«logo_1_agency» 

«greeting_style_contact_long» 

«first_name_contact» «name_contact» 

«address_contact» 

«zip_contact» 

«town_contact» 

 

«town_agency», on «today’s_date» 

«greeting_style_contact_long» «name_contact», 

 We are pleased to enclose the description of the properties likely to be of 

interest to you. 

 We wish you good reception and are at your disposal to determine a visit at 

your convenience. 

 In case your search criteria evolves, we would greatly appreciate if you let us 

know so that we can continue to serve you in the best possible. 

 

«start_zone_property» 

«title_property» 

«thumbnail 1 100%» 

«thumbnail 2 100%» 
«description» 

  Town : «town_property» 

  Usable area : «usable_area_m²»  

  Price : «price_property»  

«end_of_property_zone» 

 

«greeting_style_contact» «name_contact», we remain at your disposal for any 

question you might have. 

 

      «first_name_user» «name_user»  

      «function_user» 

 

Example of property zone: 

 

Warning: The fields «start_zone_property» and 

«end_of_property_zone» do not correspond to data but to 

tags layout. The software offers the possibility to insert, with 

the tag «end_of_property_zone», a page break to obtain, 

for example, one property per page. 
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Edit a document 

1- Click on the Tools menu 

 

 

 

2- Select Create Document (or press F11) 

3- Select a document from the list and click «Next». 

4- Select the name of the as well as the property that 

will appear in the document (The software allows you to 

choose). 

5- Print the document(s) (File menu, Print) displayed on 

the screen once the software has integrated your data in the 

desired document. 

6- Close the Activimmo word processor once your 

document is saved. 
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Edit a document template 

 

1- Click on the Customize data menu. 

2- Select Document templates. 

3- The list of templates is displayed on the screen, select 

the desired document template and click Edit. 

4- The word processor opens the selected document 

template. 

5- Edit the document. 

6- Close the window (File menu, Exit) or click on the little 

cross to close the page. 

7- Then close the document templates management 

window. (The software will ask you if you wish to save your 

document by clicking on OK). 

If you wish to train to generate document templates or 

customize them, go to tutorial No.3: Document templates. 

 

 

Add text to photos 

 

You can choose to add text, for example: COPYRIGHT on your 

photos to ensure that your photos are not used by others. You 

can create a ‘template’ and save it in the photo editor. By doing 

this, you can apply Copyright (or other text) directly to all your 

photos. 

To do so, follow these simple steps: 

- Add photos to a property in Activimmo. 

- Select a photo and click on ‘Edit’. A window opens. 

- Click on ‘Add text’ on the left of the screen. 
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- Insert the text you want to appear on your photos and 

choose: the text colour; background colour 

(transparent or solid); fonts to be used; alignment; 

appearance and transparency. When you finish, click 

on 'Apply', followed by 'OK'. 
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The text will appear at the top of your photo. When you 

position the mouse over the text, you will see a symbol appear 

in the shape of a cross. Click and move the text where you 

want it. When you are satisfied with the new text location, you 

will have the possibility to save this ‘template’ in order to be 

able to apply it to other photos. 

 

Note: To change the text color, transparency, etc., you must 

double-click on the text to open the photo editor or simply click 

'Edit text' on the left of the screen. $ 

 

 

 

- To save the text template, click the second icon on the 

top of the photo (the one on the far right: Save this 

template layout). A window will open and you will need 

to insert the name of your template (eg: Copyright) and 

click 'Save'. Your template 'Copyright' is now saved and 

is ready to be used on other photos. $ 
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To access it, click on the arrow at the top of the photo (near 

the text: $ Modèles – next to the first ‘save’ icon). Select the 

template from the drop down menu and it will be automatically 

added to your photo (same place, same font size, colour, etc.) $ 

 

 

WARNING: 

When you click OK to validate, the text will be embedded into 

the photo and you will no longer be able to edit it. 
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Web Functionalities 

Activimmo, in addition to its great capacity to manage 

properties and contacts, is also an effective tool dedicated to 

publishing properties on the Web. It is therefore possible to 

sell or offer properties in your own country as well as 

worldwide. 

- To publish or update your Website, select the Web 

menu and click on Update Website. A window allowing you to 

transfer your data to your Website will appear. After 

introducing the access settings to your website for the first 

time, click on the button Publish to update your Website. 

 

Customizing your Website 

Activimmo allows you to customize your Website. Thus, you 

can choose the pages you wish to have on your Website; create 

new pages or even choose the home page of your Website. You 

also have the possibility of having a multilingual Website. 

To access these customization options, go to the Customize 

data menu and click on Website.$ 
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- The Menu tab: This tab allows you to fully manage 

your Website menu. 

 

Tab description: 

- The drop-down list Menu Language allows you to 

choose which menu you are working (English, French, Dutch 

menu, etc.) 

 

 Note: For a multilingual Website, you must first go 

to the Customize data menu  Geographical data, select 

the Languages tab and check the box to include the desired 

language. This is also where you can choose the welcome text, 

in different languages, that appears on the home page of your 

Website. 
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- The button Selecting from first page gives you the 

opportunity to select the landing page for the user once he 

clicked on the welcome text in the desired language. 

- The first table displays the titles of your menu on the 

left half. On the right, you have the types of links which will 

point to the titles. (Homepage, search page, customize page, 

headings, etc). 

- The second table is displayed in the event of a 

Headings menu. It is identical to the previous one except that 

it is for sub-menus. 

You can add menus and sub-menus using the buttons created 

for this purpose. 

- To delete a link, right click on it and choose Delete. 

 

The Logos Tab: This tab allows you to upload your logo in 

different formats to be used in Activimmo. Thus, you can 

upload your small and medium-sized logos as well as the one 

used for your documents. You can also choose the image that 

will appear on your Website’s home page. 

 

The Photos tab: This tab allows you to upload your photos by 

giving them a specific size (height, width, compression, etc). 

 

The SEO tab: This tab allows you to include, in your Web 

pages, keywords in multiple languages that characterize your 

business and the properties you sell the most. This information 

will be used for your Website ranking on Internet and will then 

be used by search engines on Internet. 

If your keywords are well chosen to describe your business, 

your Website will perform better and you will see an increase in 

your commercial repercussions. 

 

Even more Web 

If you want even more services for your Website, contact us to 

find out about the various options available: creating 

slideshows, reserving domain names, SEO strategy, etc. 
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Manage Users 

 

The Users window enables you to record the contact 

information of sales agents and manage their access 

rights in Activimmo. 

The administrator will handle this window and manage 

users. 

 

To open the user window, select Administer Activimmo 

Users from the Management menu. 

This page consists of a main tab with a table in the center. The 

table displays key information about users. 

  

To add new users, click on «Add» or press the keyboard 

shortcut F5 or select «Insert new data» from the Edit menu 

and select the appropriate access rights. You can also find this 

action (Create) in the contextual menu, when right-clicking, in 

the employees table. 

You can also switch between different users by clicking the two 

buttons at the bottom left of the window: 

 

 

Access Rights: 

It is essential to grant the utmost attention when allocating access rights to sales agents, 

indeed, Activimmo offers three possibilities: 

1- View:  The sales agent can only view the information in the database and can not 

modify or create new records. It is therefore of restricted access and read-only. 

2- Normal: The sales agent can view the information in the database, create new 

records and edit his own records but not those of other sales agents. It is therefore the 

standard access right type for employees of a real estate agency. 

3- Administrator: It is the access right of the agency manager, in fact, besides the 

similarities with normal access rights, it allows all modifications to the database, whether 

it’s your own records as well as those of other users. Only the administrator can create 

new sales agents and assign their access rights. He is also the only one able to access the 

customization features of the application (customizing menus, update SEO, etc.) 
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Customize data 

After launching Activimmo, the first thing you see is the 

interface, the window or screen area in which you work. This 

interface is your work plan. From here you have access to all 

Activimmo tools. 

To access the customization settings, you must go to the 

Customize data menu, and then select the desired operation. 

 

 

 

Customize/Properties: Allows you to set the basic data 

used by the property window. You can also customize the 

default values that appear in the property input form and the 

types of details available. 

 

Editable parameters: 

Property: Land, parking, chateau, business premises… You can add all 

the categories you need, in several languages, by clicking on 

Add or by doing a right click and selecting Create. 

  

Property Types: 

 

A country cottage, lodging, a dungeon, a farm, a country 

mansion, a mill, a fort … You can customize your property 

types, without any limit 

 

Kitchens: This is the type of kitchen in the property: American, fully 

equipped, fitted… 

Heaters / 

Water Heaters: 

This is the type of heating / water heater used by the 

property: fuel, electricity, heating / gas water heater... 
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Conditions: This is the condition in which the property is: to renovate, 

good or bad condition. You have the ability to be concise or 

precise when describing the condition of the property. 

Surroundings: This is the area where the property is located: rural, 

suburban, downtown, waterfront, mountain... 

Operations: This is the Mandate type of the property: sale, rent, holiday 

rental... 

Zones: It is the zone of the asset: offices, holiday, residentia... 

Styles: The style of the property: architect, contemporary, character…  

Events: These are all the types of events that will be used in the 

property history and in the agenda in Activimmo (eg: 

relaunch, sending documents, etc...) 

Availabilities: This is the criteria that allow you to know whether a property 

is available or not, or when it will be. You can add all the 

criteria you want.   

Details: You can define new detail categories (description of the 

levels, inside the house, outbuildings, land, common areas...). 

In each of these details category, you can delete or add the 

values you want. 

The top section allows you to select, add or delete the detail 

categories, in multiple languages. 

The bottom section allows you to add or delete different 

values of your details (check boxes indicate that these criteria 

are listed on the Web page or can be used in documents). 

Example: For inside the house, the details can be: tapestry, 

visible stones, paintings, flooring, tiles, mosaic, linoleum... 

You are totally free and are not limited when customizing your 

categories of details. 

Translation details Allows you to translate the details used by Activimmo in 

English and other languages. 

Note: Remember to choose the secondary language in the 

drop down menu (top right). 

Price range: The price range is used in the search engine of the agency 

Website. You must first select an operation to view or add 

your price ranges. 

Mandates: This is the mandate associated to the property: co-exclusive, 

exclusive or non-exclusive. 

 

Default data : These are the default values displayed when you create a 

property. 
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Sources:  You can explain the source of the property (office, client’s tip, 

etc...) 

Tasks:  These are all tasks related to the property (advertising 

preparation, file constitution, real estate diagnosis, etc...) 

Orientation: The orientation of the property. Is the property facing North, 

South etc ... 

 

All data customization that you can perform in Activimmo are 

unlimited and can be done in a single click. 
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Customize/Contacts 
Allows you to set the basic data used by the contacts window. 

You can also set the default values which appear in the contact 

input form as well as the default criteria (Criteria tab in the 

contacts window). 

 

Editable parameters: 

 

Categories: 

 

These are the types of contacts: contacts, clients, notaries, 

owners... 

Greeting styles: These are the greetings titles: Mrs, Miss, Sir... 

 

Mat. Reg.: This is the matrimonial regime of the owner or owners. 

(separation as to property / community of property, etc...) 

 

Default data: These are the default values automatically displayed when 

creating a new contact. (Country / categories, gender, etc…) 

 

Sources: These are the details of the source of the contact. (How did 

you meet the contact...) 

 

Events: These are all the types of events that will be used in the 

contacts history in Activimmo (eg: visits, relaunches, 

telephone contact, etc...) 

 

Details: These are all the details of your contacts. 

 

Tasks: These are all tasks related to the management of your 

contacts. 
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Customize/Geographical data 

Allows you to set the basic geographical data of the software: 

create or edit towns, cities, sectors, countries and languages 

used by Activimmo. 

 

Editable parameters: 

Regions: These are the regions where your properties are located. You 

can use several languages and enter all the regions you want. 

Note: Use the secondary language from the drop down 

menu for your translations. 

 

Sectors: These are geographic sectors where your properties are 

located. You can use several languages and enter all the 

sectors you want. 

 

Towns: These are the towns where your properties are located. You 

can use several languages and enter any city you want. 

 

Country: These are the countries where your properties are located. 

 

Currencies: These are the currencies used in the countries where your 

properties are located. You can define the conversion rate in 

relation to your local currency. 

 

Languages: These are the languages used in Activimmo. If you wish to 

have your Website in English or another language, check the 

box at the end of the row. 

 

 

The Activimmo software has been designed in order to satisfy 

all real estate agencies. You can work in several languages, 

thus allowing you to work with foreign contacts worldwide. You 

can also edit the data concerning your users. In other words, if 

you have a new employee, he can easily be added to the list of 

existing users. 

In addition, you can create your own document templates: 

Activimmo thus allows you to give a personal touch to your 

agency. 
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Export data to online 

Portals 

Activimmo has a data transfer engine that allows you to 

transfer all the data you want to various real estate portals. 

Simply send a copy of your data. 

When you want to publish your ads on a portal, it will have to 

be previously registered as an advertiser in Activimmo (See 

Section Manage Ads). Then, you will be able to select the 

Web menu and use the function «Publish properties to a 

portal... » to select the portal you want. 

 

Take the example of Belgimmo: $ 
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To export your data to this portal, you need : 

- To insert your password 

- To click on the button Properties to publish. 

 

With this button, you can choose the properties that you want 

to publish from your database. You then have the option to 

publish all the properties or choose them according to specific 

selection criteria (town, amount, reference, etc...). Once you 

have selected the properties to be published, click OK and then 

click Publish. Your properties will then be published on the 

online advertiser’s portal. 

In this window, you can also choose to close the Internet 

connection and transfer all photos by checking the 

corresponding boxes. 
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Back up a copy of the data 

Activimmo offers you the possibility to back up a copy of your 

data. This feature has been designed to ensure the safe 

keeping of your data should anything happen: virus / PC 

breakdown, etc...). 

To do so, go to the Tools menu, which can be accessed via the 

Menu, and select ‘Make a backup copy of data’. 

 

 

 

In the window that appears on the screen, you must: 

- Choose a backup directory in which Activimmo will put a 

copy of the data (to select the designated directory, click the 

icon with three dots on it: ) 
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- Check the boxes that you wish to back up (database/ 

photos/ documents/ etc...) 

- If you wish to be reminded weekly to do a backup, you 

must check the box ‘Remind meto make a backup weekly’. 

- Once you are ready, click on the button Launch to start 

your backup. 

 

 

 

 

 

 

$ 

 

 

 IMPORTANT: 

It is strongly recommended to use a USB key or an external drive to 

backup your data.   

Data saved on your PC can be lost in case of PC failure due to 

unforeseen circumstances (Virus / PC formatting etc). 

ACTIVIMMO WILL NOT BE HELD RESPONSIBLE FOR THE LOSS OF DATA 

RESULTING FROM NON-COMPLIANCE WITH THE BACKUP PROCEDURE. 
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Annex: Tutorials to create 

a property 

Tutotial 1.0: Create a property 

 

Objective: In this tutorial you will learn how to create a 

property. 

 

After launching Activimmo, select the Properties menu / 

Create a property listing or «File menu / New Property» 

or Management menu/ Properties / Create a property 

listing or even use the keyboard shortcut F9 / Create a 

property listing. A window opens and asks if you want to use 

the wizard to create your property listing. 

 

 NOTE : 

The wizard gives access successively to all input forms for 

the insertion of a property listing (such as the general 

description, detailed information concerning the various 

rooms, the input form for the title and text for the publication 

of ads, the photos insert page, it also provides access to the 

data sheet of the property owner). If you do not use the 

wizard to input your property details, only the window for 

entering general information will be available. 

It is therefore recommended to always use the wizard for a 

detailed and optimal encoding for the property. 
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 The window for creating a property listing then 

appears. Fill in the blank areas of the input form and click the 

« Next »button.  

 

 

 The next window allows you to insert details 

concerning the property. For example, details about rooms 

located on the ground floor. $ 

 

 

 Then click on «Next» 

 You must then choose a title for your property in the 

new window that opens. The title chosen will be used for 
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displays and ads concerning the property. Then, fill in the ad 

text. Once done, click Next.$ 

 

 

 The next step allows you to insert photos of the 

property. To do this, click on «Click here to add photos».$ 

 

 

 

 By clicking on the folder icon: you can add a photo 

from your files. You can also insert a photo directly from your 

digital camera. To do this, connect your device to your 

computer: 

- If your camera appears directly in your browser, select 

your photos, just as if you were to look for them in your 

personnal file. 

- If your camera does not appear in your browser, use the 

program supplied with your camera to transfer images to your 
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computer and follow the procedure described in the previous 

example. 

Activimmo offers a wide array of options for editing your 

photos and add text to them using the buttons Edit and 

Actions. 

 

Note:  

Activimmo allows you to insert a «Copyright» on your photos. Thus, your photos 

definitely belong to you.  

 

 

 The new window that appears next on the screen 

allows you to enter information about the owner of the 

property if he is not already in the database. Fill in the 

appropriate fields, then click «Finish». 

 

 

 

Your property is now saved in the Activimmo database. 

 

 Note: 

Once you have created your property listing, you can 

check the information recorded by clicking on the tabs 

Property, Details, Desc. (Description) and Owner of the 

page displayed on the screen. The Media tab allows you to 

view photos of your property. 
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Tutorial 1.1: Add characteristics 

Objective: In this tutorial, you will learn how to add details on 

a property. 

 

The Details tab in the property window allows you to 

accurately describe the characteristics of a property. 

Thus, it is possible to record all specific information on a 

property such as « the kitchen equipment, the characteristics of 

each room, etc. ». 

 

 Note: You need to be in Edit mode if you want 

to edit data. 

 

 

 To add specific details on a property previously created, 

select the property and then click on the Details tab on the 

screen currently displayed.  

 

 

 

In the menu that appears to the left of the window, select the 

section of the property you need (Ground floor, etc.), then 

click «Add details about the selected property». 

 

 In addition, in this window you can: 

- Indicate an approximate value (example: If your 

property has 3 bedrooms, you can enter 3 in Section No. 

(Number) 
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- Provide a complementary description of the detail in 

different languages (to access the various languages, use the 

drop down menu with national flags). 

 

 You can duplicate the operation for all rooms or parts of 

the property before you begin to write the descriptive text.$ 

 

 

 The 4 buttons at the bottom of the window allow you 

to: switch from one detail type to the other («previous 

details and next details»), duplicate or customize a detail. 

If you click on the button $«Customize available details»$ 

(icon that looks like a colour palette), the following window 

opens: 

 



Activimmo User Manual Page   125 

 

 

Using the window in the top table (section), select the type of 

details concerned by the addition (for example, if you want to 

add the presence of a cellar in one of the outbuildings,  you 

need to select «Outbuildings»  in the top table and click 

«Add» (in the bottom window). Then enter the detail to add in 

the box that has just been created: «cellar» in this example). 

Then click OK to confirm. 

 

 Note: The bottom table enables you to insert 

details but also allows you to determine their use in the 

property publication on the Web, in the creation of 

documents or as criteria in a multicriteria search. 

 

To confirm the additions and modifications, click on the « 

Save Changes » button (on the filter bar) or through the Edit 

menu or by using the keyboard shortcut F3. The details will 

then appear in bold letters. 
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Tutorial 1.2: Add descriptions 

 

Objective: you will learn to create the descriptive texts for a 

property. 

 

 To do this, select the desired property and click on the 

tab «Description» in the center of the screen. Then select: 

- «Edit» from the Edit menu  

- Or use the edit the current data icon (3rd icon on the 

toolbar) 

- Or choose «Modify property details» on the vertical 

menu (sidebar) under ‘Properties’ 

- Or use the keyboard shortcut F2. 

 

 The window is now accessible in Edit mode. 

 

 

- You must first insert the title you have chosen for your 

window displays as well as the property publication on your 

Website. 

- This window contains 2 text boxes used to enter the 

text for the periodic ads (newspapers / magazines...) and the 

text integrated about the property on your agency’s Website. 

- The third text box allows you to change the layout of 

the property text when published on the Web. 

 To confirm the modifications made, use the keyboard 

shortcut F3 or select «Save Changes» from the Edit menu. 

You can also use the icon (shown on the left here) in the 

toolbar. 
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Tutotial 1.3: Add photos 

 

Objective: In this tutorial, you will learn to add photos to an 

already existing property.  

 

To do this, you must first open the property window and 

click on the Media tab. 

 If you want to add a new photo or add an additional 

photo for a property, select the Edit menu or use the keyboard 

shortcut F2. 

 

 If no photo was added during the creation of the 

property, click on «Click here to add photos».  

 

 

 

 By clicking on the folder icon: you can add a photo 

from your files. You can also insert a photo directly from your 

digital camera. To do this, connect your device to your 

computer: 

- If your camera appears directly in your browser, select 

your photos, just as if you were to look for them in your 

personnal file. 

- If your camera does not appear in your browser, use the 

program supplied with your camera to transfer images to your 

computer and follow the procedure described in the previous 

example. 

 To edit photos, select the Edit menu or use the 

keyboard shortcut F2. 
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The Edit and Actions buttons allow you to edit your photos in 

a photo editing software without having to exit Activimmo. 
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Tutorial 1.4: Add documents to a property 

 

Objective: In this tutorial, you will learn to add documents on 

an existing property.  

 

Activimmo gives you access to a wide range of customizable 

documents based on your properties and contacts 

(window display, client visit sheet, mandate, relaunch, 

description, sale agreement, account activity report, etc...). 

You will need to select a document from the list. You can then 

print these documents or send them by e-mail. 

 

 To create a document, open the properties window 

and select a property. Click on the Documents tab in the 

center of the screen, then click «Create a document for this 

property» or use the keyboard shortcut F11. 

 The window that opens allows you to select the type of 

document you want. Then click on «Next». Select the contact 

to which the document relates to. The document will then 

appear on the screen. 

 The left vertical menu (sidebar) offers many options: 

print the document, send the document by e-mail, export 

the document to PDF or send the document in MS Word. 

[To save the document, close the document and click «yes» in 

the pop up window.] 

 

 Note: By using the File menu / Save As, you 

can save this document in your personal files. 

 

 Summary: 

- Be in the property window, otherwise press F9. 

- Select a property (by clicking on the property in the 

table, the property row turns yellow) 

- Go to the «Documents» tab. 

- Click on « Create a document for this property» or 

use the keyboard shortcut F11. 

- Select a document and click on «Next». 

- A new window opens : select the contact to which the 

document relates to and click on «Next». 
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- Select the desired option (print, send by e-mail or in 

MS Word, export to PDF). 

- Save the document. 
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Tutorial 2.0: Create criterias for client 

Objective: In this tutorial, you will learn to reconcile the 

criteria of your prospects and properties corresponding thereto.  

Note: This function is available when creating a new contact 

[when you use the wizard, the criteria input window opens 

automatically] or when opening the contact window previously 

saved in your database by clicking on the «Criteria» tab. 

 

Creating criteria when saving a new contact using the wizard: 

- Insert your contact information and click on «Next». 

- The window for entering the criteria appears on the 

screen. Five criteria are marked in orange: Budget, Types, 

Property type, Regions and Sectors. 

 

 Criteria that appear in orange are restrictive criteria 

as those shown in black are indicative. In order to make a 

criteria restrictive, simply click on its name, it turns orange. If 

you click on the name of a criteria which is in orange letters, it 

will turn black and becomes indicative. It is up to you to modify 

them, as needed, in a single click on their name. 

 

 Note: Budget is the only exception and will always 

remain in orange colour as it is a restrictive criteria. 

 

 

 Restrictive criteria will eliminate properties that do not 

match your search criteria while indicative criteria will classify 

properties based on the satisfaction percentage (score).  
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 Fill in the fields that match your contact’s criteria then 

click «Next». 

A window opens and the software displays the properties 

corresponding to the search criteria of your contact. 

 

Creation of contact’s search criteria previously saved in Activimmo: 

- Select the contact for which you wish to add criteria. 

- Go to the Criteria tab and click on the button «Define 

search criteria». 

- Fill in the search criteria of your prospect, knowing 

that five proposed criteria appear by default in orange 

(Budget, Types, Prop. type, Regions and Sectors), which 

means that it is restrictive criteria. 

 Indeed, in a simple click on the name of a criteria, you 

decide that it is restrictive (it appears in orange) or that it is 

indicative (it appears in black). 

Restrictive criteria will eliminate properties that do not match 

your search criteria while indicative criteria will classify 

properties based on the satisfaction percentage (score). 

 

 Note: Budget is the only exception and will always 

remain in orange colour as it is a restrictive criteria  

 



Activimmo User Manual Page   134 

- When you have finished entering your client’s criteria, 

confirm with the keyboard shortcut F3. 

 

 To obtain the result of the property search, simply 

click on the tab «Properties». 

The results appear in a list, you can get all the property details 

with a single click on the house icon (on its row). 

 

 The following window opens: 
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Tutorial 2.1: Clients interested by a property 

 

Objective: In this tutorial, you will learn how to survey all 

clients that may be interested in the property.  

 

 After launching Activimmo, press on F9 or click the 

Properties menu; the properties window appears. Select a 

property (the one on which you want to do a search). 

 Click on the Client tab, the list of clients potentially 

interested by this property appears. 

 You can access the contact’s information by clicking on the 

icon (to the left of the client’s name). By doing so, a 

window opens and shows the detailed information sheet for 

the contact. 

 

 

 

 The page offers different options to check: in fact, 

you can find out if the prospects have already been 

relaunched, if they have received information about the 

selected property, you can confirm if the customer has visited 

the selected property by checking the box: 'Visited' (By doing 

so, an appointment is created in the Agenda), you can 

create a document linked to the property and the prospect or 

even exclude a contact from the list of prospects potentially 

interested by the selected property. 

 

 The button «Relaunch ‘x’ prospects»  enables you to 

create simple or grouped relaunch documents that can be 

sent  by E-mail, or create window showcase. 

 

 Summary: 
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- Press on F9 or select the Properties menu. 

- Select a property. 

- Select the Client tab. 

- The list of potentially interested clients appears (click on 

Refresh to check/update the list.) 

 

 Note: if the criteria are not defined in the contacts 

criteria tab, it will be impossible to establish a list of contacts 

potentially interested by the property.  
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Tutorial 3.0: Document Templates 

Objective: In this tutorial, you will learn to manage the 

document templates that will be useful when you send 

messages or other documents.  

After launching Activimmo, click on the Customize data 

menu, then choose Document templates. A window opens 

and gives you access to all your document templates in a list. 

 

1 – Document templates management: 

The commands associated to the documents are represented on 

the right by 7 buttons (new, duplicate, rename, delete, 

test, edit and close). 

 

 Note: You can also Import or Export documents. 

 

 

 

 

- To create a new document template, click on new and 

enter a title for your template.  

- Using the duplicate button you can create a duplicate 

copy of your document and use it as a base for creating 

editable documents. 
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- The rename button allows you to edit the title of your 

document. 

- To delete a template, select a document and click on the 

delete button on the right of the screen (or press the delete or 

Del. key on the keyboard). 

- To edit a template, double-click on its name in the list or 

click on the edit button at the bottom right. 

- When your documents are ready, click the close button. 

 

Your template is created and can be used when creating 

documents linked to the relevant property and contact. 

 

 

 

2-The integrated word processor : 

The integrated Activimmo word processor looks like any other 

word processor. However, it offers the possibility to insert data 

from your database in the form of merge fields 

 

Merge Fields: space to insert text (eg: names, addresses, details, etc. about your 

properties and contacts) or images (eg: property photos from the Activimmo database). 

You can therefore create your own document templates that will be automatically filled in by 

the appropriate details about the contacts and property(ies) concerned. 

 

 

 When opening the word processor, you will notice the 

presence of the classic menus (File, Edit, Display, Format, 
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Table and Insert) that list the usual functions such as saving, 

opening a file or setting the layout of the document, etc. 

 

 

 

 The eight remaining menus will allow you to insert 

merge fields where the text cursor is located. 

 

 Note:  

 Only the names of the merge fields will be visible in edit 

mode, they will be replaced with data during the merge. 

 If you want to see the final document, use the button: 

Preview in the top menu, or use the option: Test on the 

documents window.) 

 

 

 Summary: 

1. Customize data menu. 

2. Choose Document templates. 

3. Click on new to create a new document template and 

give it a name. 

4. The menu bar contains the classic tools for the word 

processor. 

5. The menus (Contact, Owner, Property, Offer, User 

and Agency) are used to insert specific data. 

 

Once modifications made, exit the editor and click on Close in 

the document templates window and save the changes. 


